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CUSTOMER SUPPORT
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CHAPTER 1

Introduction

Introduction

The MCII-e System controller card is the third generation controller for the ADAM Intercom System. Designed to replace the
ADAM-MC, it adds a number of key features. Adding Ethernet connectivity between the ADAM Intercom and the PC running
AZedit, the new controller can support up to 35 simultaneous AZedit sessions (32 using Ethernet and up to three (3) using
serial ports). Using a pair of MCII-e controller cards will provide full redundancy with seamless automatic change-over upon
failure.

The speed of Ethernet, combined with expanded memory, allows the card to fully support large matrices with reduced setup
file download time.

As with all ADAM Intercom family products, the MCII-e card supports all standard, hot-swappable, and configurable features
through the AZedit configuration software. It is fully compatible with existing ADAM systems and cards, including AIO-8,
AIO-16, AES-3, and RVON VoIP interfaces

NOTE: The new MClII-e System Controller card is only for use in the ADAM Matrix Intercom System and cannot be
intermixed with older ADAM master controllers in a given frame.

Features

Installation: The MCII-e System Controller card is hot-swappable and installs into slots 19 or 20 in an ADAM
Intercom System.

Trunk Capable: The MCII-e System Controller card supports ancillary data control for use with Telex Intelligent

Trunking.

Ethernet Compatible:  Fully Ethernet capable. The MCII-e provides a single RJ-45 connection for use with a 10BASE-TX or
100BASE-TX compliant and network. Each system controller has its own IP Address network access.

AZedit Configurations: The MClI-e can connect to AZedit via Ethernet or Serial (RS-232) connections. Also, the new
Intercom Sizing Wizard in AZedit makes configuring the new system controller card easier than ever.

Controls: Reset button switch, general indicators, an LED module for advanced monitoring features and for
gathering additional card information.




Specifications

Specifications

Power
75W /1.5A @ 5V

Physical
5.687” (144.45mm) W x 11.024” (280.01 mm) L
Connectors
SCSI connector via backcard
RJ-45 Ethernet via backcard
Miscellaneous
4 Mbytes of Code Flash
32MB of SDRAM
8Mbytes Configuration Flash

System Diagram
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FIGURE 1. System Diagram - MCII-e Master Controller




Reference View - Front Card
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Reference View - Front Card

FIGURE 2. MClI-e System Controller Card Board view.




Reference View - Front Card

Reset Button

Fail LEDs

ON, if acting as the active controller. OFF, if acting as standby.

Flashes while transmitting data on control bus to another card

Flashes while receiving data on control bus from another card

Flashes while transmitting data on private bus to active or standby partner controller

Flashes while receiving data on private bus from active or standby partner controller

ON, if Trunk Master is alive and connected.

Not used (future)

Not used (future)

Illuminated when the corresponding internal task is running
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The rest of the green LEDs
show which 10 cards are
alive.

For example,
23 =1/0 Card in Slot 16 is alive and talking

10 =1/0 Card in Slot 3 is alive and talking
9 =1/0 Card in Slot 2 is alive and talking
8 =1/0 Card in Slot 1 is alive and talking

NOTE: There is no LED for I/O card in slot 17.

Gives (in binary) the
slot number (1-19) of
the card that the MC
is currently talking with
over the control bus.

Or when all the LEDs are
off, the MC isn’t

talking to a card over
the control bus.

This changes rapidly in
normal operation.

>Push button 1 Bypass Debug-ONLY
Push Button 2 Unassigned

FIGURE 3. LED Descriptions for the MCII-e




Reference View - Back Card

Reference View - Back Card
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RJ-45 Ethernet Connection

68-pin SCS/ Connection

FIGURE 4. Back Card




DIP Switches

DIP Switches

Closed

Open

FIGURE 5. Dip Switch SE02

TABLE 1. PCII-¢ Version 1.19.2 Dip Switch Settings

1 Debug Only! Must be in OPEN position.

2 Sets the baud rate for the AZedit serial connection via J1. By default, AZedit is set for COM 1 and 38,400
kbps (38.4K). The baud rate set in AZedit must match the baud rate setting of the Master Controllers in
ADAM.

DEFAULT = CLOSED
OPEN = 9600
CLOSED = 38.4k Baud

Reserved, keep in OPEN position.

Reserved, keep in OPEN position.

Reserved, keep in OPEN position.
Debug Only! Must be in OPEN position

N | N b~ W

Determines Master/Slave Frame in a multi-frame system.

DEFAULT = CLOSED
OPEN = Slave Frame
CLOSED = Master Frame

8 Debug Only! Must be in OPEN position.

IMPORTANT: DIP Switches 1, 6, and 8 should always be left in the open position. These are reserved for debugging
and can have unintended consequences if not in the open position.




DIP Switches

TABLE 2. MCII-e Version 1.6.2 Dip Switch Settings

1 Debug Only! Must be in OPEN position.
2 Sets the baud rate for the AZedit serial connection via J1. By default, AZedit is set for COM 1 and 38,400

kbps (38.4K). The baud rate set in AZedit must match the baud rate setting of the Master Controllers in
ADAM.

DEFAULT = CLOSED
OPEN = 9600
CLOSED = 38.4k Baud

Reserved, keep in OPEN position.

Reserved, keep in OPEN position.

Reserved, keep in OPEN position.
Debug Only! Must be in OPEN position
Reserved, keep in OPEN position.
Debug Only! Must be in OPEN position.

||| N bW

TABLE 3. MCII-¢ Version 2.0.0 and Higher Dip Switch Settings

1 Debug Only! Must be in OPEN position.
2 Sets the baud rate for the AZedit serial connection via J1. By default, AZedit is set for COM 1 and 38,400

kbps (38.4K). The baud rate set in AZedit must match the baud rate setting of the Master Controllers in
ADAM.

DEFAULT = CLOSED
OPEN = 9600
CLOSED = 38.4k Baud

Reserved, keep in OPEN position.

Reserved, keep in OPEN position.

Reserved, keep in OPEN position.
Debug Only! Must be in OPEN position
Reserved, keep in OPEN position.
Debug Only! Must be in OPEN position.
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Introduction

Connector Pinouts General Purpose
. X J-4 of
AZedit #1 68-pin Master v -p ApAM-  Assignment 2W
Controller
\Y (6
68-pin Master J-1 of 1 1 RS485 TX/RX-
Cp ntroller XCP-ADAM- Assignment 2W
° \Y (& 43 2 Ground
1 1 RS485 TX/RX- 3 Not Used
3 2 RS232C RX 4 Not Used
37 3 RS232C TX 46 5 RS422 TX+
4 RS422 TX- 45 6 RS485 TX/RX+
5 Ground 43 7 Ground
2 6 Ground 8 Not Used
38 7 RS422 TX+ 12 9 RS422 TX-
35 8 RS485 TX/RX+
9 General Purpose
68-pin Master J-5 of
Trunking System “pin Vaster XCP-ADAM-  Assignment 2W
Controller MC
68-pin Master J-2 of 1 1 RS485 TX/RX-
C[())n troller XCP-ADAM- Assignment 2W
\Y (& 14 2 Ground
5 1 RS485 TX/RX- 3 Not Used
36 2 Ground 4 Not Used
6 3 RS232C RX 5 Not Used
4 Not Used 47 6 RS485 TX/RX+
41 5 RS422 TX+ 14 7 Ground
39 6 RS485 TX/RX+ 8 Not Used
36 7 Ground 9 Not Used
40 8 RS232C TX
7 9 RS422 TX- General Purpose / Bus Exp.
68-pin Master J-6 of
UI0-256/PAP/LCP “pin Vaster XCP-ADAM-  Assignment 2W
Controller MC
68-pin Master J-3 of 15 1 RS485 TX/RX-
Cl())n troller XCP-ADAM- Assignment 2W
\Y% (& 48 2 Ground
1 RS485 TX/RX- 3 Not Used
9 2 Ground 4 Not Used
3 Not Used 5 Not Used
4 Not Used 49 6 RS485 TX/RX+
44 5 RS422 TX+ 48 7 Ground
42 6 RS485 TX/RX+ 8 Not Used
9 7 Ground 9 Not Used
8 Not Used
10 9 RS422 TX-

10




Introduction

General Purpose / Bus Exp. AZedit #3
686pin Master XCI;I:ZI(;;M- Assignment 2W 68-pin Mast.er XC.II’-X}DO:M- Assignment 2W
ontroller MC Controller MC

16 1 RS485 TX/RX- 1 Not Used

17 2 Ground 67 2 Ground
3 Not Used 21 3 RS232C RX
4 Not Used 4 Not Used
5 Not Used 5 Not Used

50 6 RS485 TX/RX+ 6 Not Used

17 7 Ground 67 7 Ground
8 Not Used 54 8 RS232C TX
9 Not Used 9 Not Used

General Purpose / Bus Exp.

68-pin Master Cl;'_'i lngM_ i o
Controller gnmen
\Y (@

18 1 RS485 TX/RX-
51 2 Ground

3 Not Used

4 Not Used

5 Not Used
>2 6 RS485 TX/RX+
ol 7 Ground

8 Not Used

9 Not Used

AZedit #2
686pin Master XCI;I-zl())f&M- Assignment 2W
ontroller MC

1 Not Used

19 2 Ground

20 3 RS232C RX
4 Not Used
5 Not Used
6 Not Used

19 7 Ground

53 8 RS232C TX
9 Not Used

11




Introduction

General Purpose

. Q

R

E *E ; é Assignment

35 &

= 8
22 1 MI (0) Logical Input (0)
23 2 MI (1) Logical Input (1)
24 3 MI(2) Logical Input (2)
25 4 MI(3) Logical Input (3)
26 5 MI (4) Logical Input (4)
27 6 MI (5) Logical Input (5)
28 7 MI (6) Logical Input (6)
29 8 MI (7) Logical Input (7)
30 9 Ground Ground
31 10 Ground Ground
32 11 Ground Ground
33 12 Ground Ground
34 13 Ground Ground
55 14 MO (0) Logical Output (0)
56 15 MO (1) Logical Output (1)
57 16 MO (2) Logical Output (2)
58 17 MO (3) Logical Output (3)
59 18 MO (4) Logical Output (4)
60 19 MO (5) Logical Output (5)
61 20 MO (6) Logical Output (6)
62 21 MO (7) Logical Output (7)
63 22 Ground Ground
64 23 Ground Ground
65 24 Ground Ground
66 25 Ground Ground

12




CHAPTER 2

Configuring the MCIl-e

System Requirements

IMPORTANT:
If you are using:
e A single, frame system, you must be using MCII-e version 1.6.2 or later.
e A multi-frame system with DBX cards, you must be using PCII-e version 1.19.2 or later.

e A multi-frame system with Tribus cards, you must be using MClII-e version 2.0.2 or later.

Before you configure your MCII-e System Controller card, verify the following items are updated:

e AZeditv2.08.01 or later

e AIO-8v 10.3.4 or later

e AIO-16 v 1.0.0 or later

e  Periph-Ile, requires DBX v1.14.0 or later

NOTE: Field upgrade of DBX will requires Boot Code upgrade to version 0.0.3. If the Boot Code is not upgraded, the
DBX card will not work with the MCII-e. Refer to DBX Boot Code Upgrade (P/N 38110-472) which can be
found on the rtsintercoms.com.

13



Default Ethernet IP Addresses

Default Ethernet IP Addresses

Product Default IP Address Default Subnet Address
RVON-I/O 192.168.0.1 255.255.0.0
RVON-8 192.168.0.2 255.255.0.0
RVON-1& RVON-2 192.168.0.3 255.255.0.0
RVON-C 192.168.0.4 255.255.0.0
RVON-16 192.168.0.5 255.255.0.0
GPIO-16 192.168.0.6 255.255.0.0
MClI-e 192.168.0.7 255.255.0.0
Cronus 192.168.0.8 255.255.0.0
Zeus 111 192.168.0.9 255.255.0.0

Ethernet Setup for MClI-e System Controller

Set the IP Address for the MCII-e System Controller

NOTE: The PC must be running version 2.08.01 or later of AZedit and have an Ethernet card installed. The MCII-e can
support up to 32 concurrent sessions of AZedit on Ethernet.

Verify the MCII-e is connected to the PC using a RS232 (ADAM standard) cable. Connect J1 on the XCP-ADAM-MC to the
COM port on the PC.

NOTE: For more information on Network Basics, see the Basic Networking Guide found at http://www.telex.com/
Intercoms/files.nsf/sitemap#Brochures, under Applications.

If there are two (2) controllers, they must each have their own unique IP Addresses (different from each other and any other
devices sharing the same network).

14



Ethernet Setup for MCll-e System Controller

To connect the Active MCII-e to the PC with a serial cable, do the following:

1.

Open AZedit.
The Keypanels/Ports screen appears.

From the Option menu, select Ethernet Setup.
The Ethernet Setup screen appears.

Ethernet Setup EHE

—Left Controller

IP Address: m . oz . z10 ., 5

Metwark Mask: | 755 . 255 . 755 . 0

Default Gateway: | 10 . 2 . 210 . 2

MAC Address: |8III:IZIIZI:IIIIII:FF:FF:1'§J

—PRight Controller

Paddess: | 0 . 0 . 0 0

Metwark Mask: | o . o0 .0 .0

Default Gateway: I o .o .0 . @

MaC Address: |DD:DD:DD:DD:DD:DD

Al |
[ o= |

Close

In the IP Address field, enter the IP Address for the current MCII-e System Controller.
In the Network Mask field, enter the Network Mask number for the current MCII-e System Controller.
Where appropriate, in the Default Gateway field, enter the Gateway number for the MCII-e System Controller.

NOTE: If the MCII-e communicates with hosts outside its network, enter the IP address of a host or router which
will serve as the Gateway. Otherwise, if the MCII-e only needs to communicate with the local network,
leave the Default Gateway field at its default setting (0.0.0.0).

The Default Gateway is normally configured the same on both the active and standby MC-II-e System
Controller Cards.

The same screen you use to set the network settings can be used to view the settings as well. You must be
connected using a serial connection via J1 to make changes, but you can view them with any type of AZedit
connection (J1, J9, J10, or Ethernet).

Click Apply.

Click Close.

The Ethernet Setup window is closed.

Connect the MCII-e System Controller to your network with an Ethernet cable.

NOTE: The unique Ethernet MAC address assigned to each MCII-e card during manufacturing is displayed in the
field MAC Address. It is NOT possible to modify this address.

Connect the PC to your network with an Ethernet cable.

NOTE: If you do not know these numbers, your system administrator can supply the IP Address and Netmask to
use.

15



Ethernet Setup for MCIl-e System Controller

To configure the communication settings, do the following:

1. From the Options menu, select Communications.
The Communication screen appears

Communications

2| x|
A7 edit Sezsion
— Connection— COM Port — Baud Rate =
" Serial comi =] | |284keps =] Concel
) UGB ~ P Address
Main: [192.168.1.38 =
Partrier: In-’a

2. In the Connection area, select the Network radio button.
3. Inthe IP Address field, either enter the MCII-e IP Address you wish to connect with, or click the Search

button. | J

The search button scans the network for any MClIl-e devices. If multiple units are on the network, each will appear in
the list.

Available Intercoms 2 x|

—Intercoms

—Selected Inkercom

Mame: |LOCL
Tvpe: |MCII-e System Controller
Status: | Active
IP Address:  [192.168.1.38
IP Partner: |
Connections: | 31/32 Available
Descripkion; |.C\D.0.M MCII-e Master Controller

OF I Zancel

4. Select the MCII-e System Controller you wish to work with.

5. Click OK.
The Communications screen closes. The IP Address is configured in AZedit for the MCII-e System Controller.

16



Download Firmware for the MCll-e System Controller

Download Firmware for the MClI-e System Controller

CAUTION: The following procedure will cause one or more brief disruptions in intercom communications. Also, SAVE your

intercom system configuration. From the File menu, select SAVE. Later, if you need to restore the intercom
configuration from disk, use Send File in the Online Menu.

IMPORTANT: Before you begin, be sure to verify that SERVER mode has been disabled. Also, it is extremely

NOTE:

important to take the Standby Controller card out of the frame, if one is installed.

The Active Master Controller has the topmost red LED (#23) on in the status window.

To download master controller firmware, do the following:

1.

From the Status Menu, select Software Versions.

A popup list appears.

From the Software Versions popup list, select Master Controllers.
The Master Controller Version Information screen appears.

Right-click the active Master Controller, and then select Download Firmware.
The Firmware Download screen appears.

NOTE: You can also press Ctrl+Shift+D to open the Firmware Download screen once the Master Controller is
highlighted.

From the Firmware Download screen, select the firmware update file.

Or

Use the browse button to navigate where the new file resides.

Click Open.

The firmware update appears in the Download Firmware screen.

Click Begin Download.

This process can take as little as 30 seconds with “Fast Ethernet” or as long as five minutes when using a serial
connection at 9600 baud.

NOTE: If there is any disruption in the communication link during the download, you will get an error message. In
this case, repeat the download.

When the file has been completely downloaded, the MCII-e System Controller will begin processing the update.

7.
8.
9.

IMPORTANT: Any disruption at this point, such as loss of power, removing or resetting cards may result in Master
Controller failure. If this happens, you will have to return the affected unit for replacement or
repair.

The AZedit session goes offline for 15-20 seconds when the card performs a reset. It automatically
reconnects when finished.

When the Master Controller is finished, the new software version will appear in the version field of
the Version Status screen.

If you do not have a Standby Master Controller card, you can skip steps eight and nine.

Once the Active Master Controller is updated, remove the Master Controller from the frame.
Insert the Standby Master Controller and repeat steps 3 through 8.
When the Standby Master Controller is finished, insert both controllers and resend your system setup file.

17



Download Firmware for the MCll-e System Controller
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CHAPTER 3

Accessories

Accessories

G

O

ETHERNET
J1

D <«— RJ-45 Ethernet Connection
act O
LINK O

68-pin SCSI Connection

"\

a 52 43 J4 J5 J6 J7 J8 J9 J10
’ =
- ADAM-MC

J2

ADANM-M(

! Lo

O AZedit #1 UIO/PAP/ AZedit #2 GRUO
LCP
Trunking Additional AZedit #3
System PAPs Future Use

FIGURE 6. Connection Diagram. The 68-pin SCSI can be attached to the XCP-ADAM-MC.

NOTE: AZedit sessions are only enabled on J9 or J10 when the advanced communication boxes are enabled from
“communications” screen and the correct baud rates are configured.

XCP-ADAM-MC Master Controller Breakout Panel

The XCP-ADAM-MC Breakout Panel allows many different peripherals to be connected to the master controller of an
ADAM Intercom System, such as AZedit, trunking systems, UIOs, PAPs, LCPs, GPI/Os, etc. For the breakout panel pinouts,
see pages 9-15.

19



Accessories

AZedit

AZedit is a Windows-based, full-featured configuration software, providing online and offline configuration capabilities. It
gives you the ability to manage multiple intercom systems, assign and reassign users to different ports, as well as dynamically
add hardware to your system setup without jumper changes, rewiring, or taking the system offline. AZedit has the capability to
load pre-set configuration files, which means configurations saved to a disk can be uploaded to the “live” application at
anytime, without interruption.

The XCP-ADAM-MC breakout panel has three DB-9 connectors that can be used to connect to AZedit (AZedit #1, #2, and
#3).

Trunking Systems

The RTS™ Trunking System manages intercommunications between separate intercom systems using intercom ports that
have been reserved and interconnected between the intercom systems with devices in other frames. Keypanels or other data
devices can then communicate with devices in other frames.

UIO-256

Each UIO-256 provides 16 GPI inputs and16 GPI outputs. The GPI inputs can be used just like keypanel keys to activate
intercom ports, party lines, relays, etc. Each relay output provides a choice of normal open and normal closed contacts. The
relays can be assigned for activation from keypanel keys, and can be used to control lighting, or to key remote transmitters,
paging systems, etc.

PAP

Program Assist Panels provide a fast and easy method of selecting any of several program sources (connected to input ports
of the intercom system) for use with the IFB outputs feature of the intercom system.

LCP

The LCP panel (Level Control Panel) combines the functionality of three products into one. The LCP allows you to adjust
analog input and output gains, assign sources to IFB outputs and make changes on the fly, and to add members to a party line
on the fly.

GPI/O (General Purpose Input/Output)

J11 provides 8 general purpose control inputs and 8 general purpose control outputs. The control inputs can be used just like
keypanel keys to activate intercom ports, party lines, relays, etc. The control outputs are open-collector, active-low outputs.
They can be activated by keypanel keys and can be used to control lighting, to key a remote transmitter, to activate a paging
system, etc.

Pin-outs for the digital inputs and outputs are summarized in “Connector Pinouts” on page 10.
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CHAPTER 4

Trunking and the MCIl-e System

Trunking and the MClI-e System Controller

Trunking allows one intercom system to communicate with another remote intercom system with devices in other frames. For
example, a user in New York can talk to a user in Los Angeles if the systems they are using are trunked together. Trunking can
be configured to work with cables, fiber optics, voice over internet protocol, or any form of audio/data transfer media, to allow
communication between systems.

Enable Trunk Support In AZedit

To trunk the MCII-e System Controller Card, do the following:
1.  From the AZedit main menu, select Options.
The Options sub-menu appears.

2. From the Options sub-menu, select Preferences.
The Applications Preferences screen appears.

3. On the Applications Preferences screen, click the Advanced tab.
The Advanced screen appear.

4. On the Advanced screen, select Enable trunking support.

5. Click OK to save the change and close the screen. Or, click Apply to save the change and leave the screen open.

When your system has limited bandwidth, you want to set the Allow for Remote Trunk Master. By setting this option, the baud
rate is changed to 9600 baud, instead of the default, 38.4K.

To enable the Remote Trunk Master, do the following:

WARNING: Enabling this option will cause the system to reset. All data will be erased in the frame. Be sure to save your
system setup to disk before performing this task.
1. Remove the Standby Master Controller.

2. From the AZedit main menu, select Options.
The Options sub-menu appears.

3. From the Options sub-menu, select Intercom Configuration.
The Intercom Configuration screen appears.

4.  On the Intercom Configuration screen, click the Options tab.
The Options screen appears.

5.  On the Options screen, select Allow for remote trunk master.

6. Click Test to verify the intercom will accept the new settings.
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Trunking and the MCll-e System Controller

7. Click Apply.
The intercom will stop communicating with AZedit, reconfigure itself, and then reset.

Resend the current setup.

9. Replace the standby controller.
It will automatically reconfigure itself to match the new settings.

Connect The MCII-e To The Trunk Master (Data)

To connect MClII-e to the Trunk Master, do the following:

>  Connect the MCII-e System Controller Card data connector to one of the eight DB-9 connections on the ICP-
2000.

Configure The Trunkmaster To Communicate With The MCII-e System Controller Card

To setup the TrunkMaster to be able to communicate with MCII-e, do the following:

1. Open TrunkEdit.

2. Inthe left navigation, open the Intercom slide screen.
The Intercom navigation panel displays.

[EZ Trunk Edit - [ONLINE]

File ©rnline Edit Yiew Trunk Intercom Diagnostics Help
DEREHE| FRBAA XD S5 ERE e |82

Trunk.

Intercom Setup

Definitions Icom # IName 4 /i Mame & | Narne § | Baud Rate | COM Port | OR? | Cur | New | Type | Size | Skatus
4 CRON CRON 36.4K 4 © ° © 7 128 Lost contact
° Summary 1 INT1 INT1 NT1 36.4K 1 b i i ADAM-CS 64 Up to date
P 2 NTZ T2 T2 35.4K z A i i) ADAM 256 Up to date
3 9600 3 Mo communication
m Cptions 5 36.4K 5 Mo communication
=] 36.4K 3] Mo communication
7 36.4K 7 Mo communication
g 36.4K g Mo communication
S 9 36.4K = = = = = Mo communication
m Status 10 384K © ° © © © Mo communication
11 36.4K = = = = = Mo communication
Alphas 1z 354K = = = = = Mo communication
13 354K ° = ° ° ° Mo cammunication
Rl 14 35.4K - - - - - Mo cammunication

3. From the Intercom navigation, select Setup.
The Intercom Setup screen appears.

4. In the Intercom Setup screen, enter the Intercom System Name (i.e.; ADAM) in the appropriate ICOM port (for
example, if the MClI-e System Controller is cabled to the ICP-2000’s J4 connector, then in the Intercom Setup
screen, enter the MCII-e’s machine name in the line which corresponds with the COM port #4 field).

5. Select the Baud Rate field and enter the baud rate to match the baud setting of the Intercom Trunking port (38.4K or
9600).

6. When you are finished, click the Send button to send the changes to the Trunk Master. When the changes are sent to
the Trunk Master, the MCII-e connects to the Trunk Master and uploads the remote ports. Once the MCII-¢ has
uploaded this data, it sends its port alphas to the Trunk Master.

In AZedit
1. Open AZedit.
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2. On the main screen, select the port you want to make available remotely.

LH-E AZedit - [Untitled] - Keypanels / Ports

File ©Online Edit Yiew Swstem Alphas Status  Options  Logging  Help

0|2 & &= .a] <]

o] 2] 458 Q| «»| o W

3. In the Scroll Enable ficld, select Trunk and AZedit.
By enabling Trunk and AZedit on this port, remote users will display in AZedit and remote keypanel users will be able

to see enabled ports.

NOTE:
4. Send the changes to AZedit.

In TrunkEdit - Define the trunk line

NOTE:

—Port Alpha Scroll Enable Keypanel f FPort Settings
g NOO3 | :;';”'“"L IF'age1:Main -I Edit... |{*I<Jl)|
et
M LcPioz
r Lizten Keys
o nl r r nl r r nl r r
R r r I r r I r I I

We recommend that you only enable user positions that will be used by remote systems.

We recommend you map your system before defining the trunk lines.

Defining the trunk line shows where a trunk line begins and ends, as well as shows the audio connections between frames.

£ Trunk Edit - [ONLINE]

File ©nline Edit Wew Trunk Intercom Diagnostics Help

DS EHES FRAA DS 5 BRR @R

Alphas

Groups

To define trunk lines, do the following:

Trunk Definitions for: All Intercoms

Trunk # /.

State

Icom 1

Port

| Alpha

Icom 2

[ Part

| Alpha

Idle

Idle

Idle

Idle

Idle

Idle

Idle

1
2
E
4
5 Idle
-]
7
8
9

Idle

10 Idle

i1 Idle

1z Idle

13 Idle

14 Idle

TNT1

INT1

N33
N34

HO14

MO33
MO34

MO14

INTZ
INTZ

INT1

N105
N10&

NOOS

N10S
N10&

WOOS
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Open TrunkEdit.

In the left navigation, open the Trunk slide screen.
The Trunk Definitions for: All Intercoms panel displays.

In the ICOM 1 field, enter the intercom name of one end of the trunk connection (i.e.; ADAM).

In the Port Field, enter the port number where ICOMI1 is assigned (i.e.; NO14). Or, in the Alpha field, enter the
Alpha of the ICOM1 system (i.e.; N014).

In the ICOM?2 field, enter the name of the system ICOM1 is linked to (i.e.; INT1).

In the Port field, enter the port number where ICOM? is assigned (i.e.; N0OS5). Or, in the Alpha field, enter the alpha
of the ICOM2 system.

Once finished with all your definitions, Send the changes to the TrunkMaster.

In AZedit

Once you are finished defining the trunk lines of your system, you can use AZedit to make key assignments for the keypanels.
With Trunking enabled, you will be able to see all trunked system and their ports enabled in AZedit.
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